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Introduction to Simulink

There are several computer packages for finding solutions of dif- Most of these models were created
using Version 2015. Some changes in
Versions 2017-2020 are noted.

ferential equations, such as Maple, Mathematica, Maxima, MATLAB, etc.
These systems provide both symbolic and numeric approaches to finding
solutions. They often require a bit of coding. However, there are graphical
environments for solving problems, including differential equations. One
such environment is Simulink, which is closely connected to MATLAB. In
these notes we will first lead the reader through Simulink examples of so-
lutions of first and second order differential equations usually encountered
in a differential equations course. We will then look at examples of more Examples of MATLAB solutions of

differential equations will also be
provided.

complicated systems.

1.1 Solving an ODE

Simulink is a graphical environment for designing simulations
of systems. As an example, we will use Simulink to solve the first order
differential equation (ODE)

dx
dt

= 2 sin 3t− 4x. (1.1)

We will also need an initial condition of the form x(t0) = x0 at t = t0. For
this problem we will let x(0) = 0.

We can solve Equation (1.1) by integrating
dx
dt

to formally obtain

x(t) =
∫
(2 sin 3t− 4x(t)) dt.

We will view this as a system in which the input, x′ = 2 sin 3t− 4x, is fed
into an integrator and the output will be x(t). Generally, we have

x(t) =
∫

x′(t) dt.

This process is depicted in Figure 1.1.

input
∫

output
xx′ Figure 1.1: Schematic for a general

system in which the block takes the
input and produces an output.

In order to carry this out, we separately insert the terms 2 sin 3t and
−4x into the integration procedure. Since we do not know −4x, we take
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the output from the integrator, multiply it by 4, and subtract that from
2 sin 3t. This combined set of terms is then feed back into the integrator.
This is shown schematically in Figure 1.2.

2 sin 3t
∫

output

×4

+−
xx′ Figure 1.2: Schematic for solving

x′ = 2 sin 3t− 4x. The terms 2 sin 3t and
4x are fed into the integrator and x is
output.

When you have access to Simulink and MATLAB, you can start MAT-
LAB by typing simulink on the command line to bring up Simulink. Al-
ternatively, you can select Simulink on the MATLAB icon bar to launch
Simulink. Starting in 2017 Simulink opens with a start screen in which
there are several selections as shown in Figure 1.3.1 Pick the Blank Model 1 In earlier versions the Simulink Li-

brary Browser in Figure 1.5 would
appear.

to begin a new model or select a recently opened model. Then, you will be
in the Simulink workspace [see Figure 1.4].

Figure 1.3: The Simulink Start screen.
Pick the Blank Model to begin a new
model or select a recently opened
model.

From the workspace you can open the Simulink Library Browser as
shown in Figure 1.52. Next, click the yellow plus to bring up a new model. 2

We build models by dragging and connecting the needed components, or
blocks, from groups such as the Continuous, Math Operations, Sinks, or
Sources.

Now we can create the model for simulating Equation (1.1) in Simulink
as described in Figure schema2 using Simulink blocks and a differential
equation (ODE) solver. In the background Simulink uses one of MAT-
LAB’s ODE solvers, numerical routines for solving first order differential

equations, such as ode45. This system uses the Integrator block3
1
s

Integrator

to

3 The notation on the Integrator block is
related to the Laplace transform

L
[∫ t

0
f (τ) dτ

]
=

1
s

F(s),

where F(s) is the Laplace transform of
f (t).

integrate
dx
dt

, producing x(t).
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Figure 1.4: A blank model in Simulink.

The input for the Integrator is the right side of the differential Equation
(1.1), 2 sin 3t − 4x. The sine function can be provided by using the Sine
Wave block, whose parameters are set in the Sine Wave block. In order to
get 4x, we grab the output of the Integrator (x) and boost it by changing
the Gain value to “4” Then, using the Sum component, these terms are
added, or subtracted, and fed into the integrator. The Scope is used to
plot the output of the Integrator block, x(t). That is the main idea behind
solving this system using the model in Figure 1.6.

For this example, we implement the following detailed steps in Simulink:

• Drag needed blocks into the model region [Figure 1.7.]:

– Integrator block from the Continuous group;

– Sum block from the Math Operations group,

– Gain block from the Math Operations group,

– Sine Wave block from the Math Operations group; and,

– Scope block from the Sink group.

• Connect the output of the Sum block to the input of the Integrator
block. [Figure 1.8.]

• Connect the Integrator to the Scope by clicking on the Integrator out-
put and dragging to the Scope until they are connected. In more recent
versions it is easier to double-click the unattached arrow to get a con-
nection.

• Right-click the Gain control and choose Flip Block under Rotate &
Flip. Double-click the Gain block and change the Gain block value
from 1 to 4. It should change on the control.
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Figure 1.5: The Simulink Library
Browser. This is where various blocks
can be found for constructing models.
[As seen in MATLAB 2015a.]

1
s

Integrator

4

Gain

ScopeSine Wave

Function

Figure 1.6: System for solving first
order ODE dx

dt = 2 sin 3t − 4x as a
Simulink simulation.

• Double-click the Sum control to bring up Block Parameters as shown in
Figure 1.9 and change from |++ to |+- in order to set addition/subtraction
nodes. [Note that the symbol ‘|’ is a blank node. Also, one can change
the block to rectangular form. This is often useful in displaying an over-
all flow direction to the model. In this case the spacer, |, is not needed.]

• Double-click the Sine Wave block and change the frequency to 3 rad/s
and the amplitude to 2. [See Figure 1.10] Set the time dropdown menu
to Use Simulation Time.

• Connect the Gain output to the negative input of Sum and the Sine
Wave output to the positive input on the Sum control. [Note: The Gain
can be set to a negative value and connected to a + node in the Sum
block to obtain the same effect.]

• To add a node to route an x value to the Gain, hold the CTRL key and
click on the Output line of the Integrator and drag towards the input
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1
s

Integrator ScopeSine Wave

1

Gain

Figure 1.7: Add needed components to
the model window.

1
s

Integrator ScopeSine Wave

1
s

Integrator ScopeSine Wave

Figure 1.8: Example of connecting
two components: Align the compo-
nents, Click on output of one and drag
to another. Then, release to finalize
connection. Sometimes it is easier to
double-click the temporary arrow to
connect the blocks.

of the Gain. You can also Right-Click the line where you want the node
and drag from there to the Gain block. See Figure 1.11.

• The initial value, x(0), of x is inserted by double-clicking the Integrator
and setting the value. For this example we set x(0) = 0.

• One can annotate the diagram by clicking near where labels are needed
and typing in the text box. This leads to the model in Figure 1.12. In
more current versions the default is to hide block names.

In Release 2017b the names of blocks
are hidden. One can change this by
going to the block Properties and
changing the block parameter for
’HideAutomaticName’ or change the
model parameter ’HideAutomatic-
Names’.

• Save the file under a useable file name. This file can be called in
MATLAB, or one can use the run button to run the simulation.

• Double-click the Scope to see the solution. Figure 1.13 shows the Scope
plot after using the autoscale ( ) feature to rescale the scope view.
A little effort is needed to change the plot attributes and to import the
plots into working documents. This will be discussed in Section 1.4.

• Also, one can make further changes to the system by checking the Con-
figuration Parameters under the Simulation menu item. See Figures
1.14-1.15. In particular, changing the Refine Factor can lead to smoother
solutions. The solution shown in Figure 1.13 had a setting of 1 and that
in Figure 1.16 is the result of setting the Refine Factor to 10.

As noted in setting the initial value, one can double-click the Integra-
tor block and set the initial condition. However, sometimes it is useful to
externally feed the initial condition into the block. Double-click the Inte-
grator block and change the initial condition source from internal to exter-
nal. This adds another input to the block. Drag a Constant block from the
Sources group into the model, connect it to the new input, and change the
constant value to the desired initial value. This results in the simulation
shown in Figure 1.17.
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Figure 1.9: Block Parameters for the
Sum control. In many cases it is best to
also select the rectangular shape over
the default round shape.

1.2 Handling Time in First Order Differential Equations

In this section we review the solutions of first order differential equa-
tions, separable first order differential equations and linear first order dif-
ferential equations involving explicit time dependence. The time depen- The independent variable is obtained

using the Clock block.dent functions are obtained using the Clock block and a Math Function
block. Double-clicking the Math Function block allows for the selection of
a number of common functions.

Example 1.1. Solve the initial value problem

dy
dt

=
2
t

y, where y(1) = 1. (1.2)

This is a separable equation. Placing y-variables on the left and
t-variables on the right side, we have∫ dy

y
=
∫ 2

t
dt.

Integrating both sides,

ln |y| = 2 ln |t|+ C = ln t2 + C.

Exponentiating, we obtain the general solution,

y(t) = At2,

where A = ±eC.
Using the initial condition, we have the solution, y(t) = t2.

We can set up the problem in Simulink as shown in Figure 1.18 for the
initial value problem

dy
dt

=
2
t

y,
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Figure 1.10: Parameters for the Sine
Wave block. Select the amplitude and
frequency desired.

1
s

Integrator ScopeSine Wave

1

Gain

Figure 1.11: Add a node by right-
clicking one the line and dragging to
the input of a block.

where y(1) = 1. Running the simulation, we obtain the solution shown in
Figure 1.19.

The solution looks like y(t) = t2. We can verify this by plotting t2 along
with the solution t see if they are the same. Another method would be to
compute the difference between the numerical and exact solution, y(t)− t2.
In order to do this, we add a Math Function block, selecting the square
function and connect it to the time route and a Sum Block. The solution is
also fed into the latter block and the difference is fed into a second Scope
Block. This is shown in Figure 1.20.

The result of the simulation is shown in Figure 1.21. We note that this is
the numerical error, though the solution is only off by 1.4× 10−5 over the
given interval. Considering that the solution at t = 10 is Y(10) = 100, this
is a relative error of roughly 10−7. That seems perfectly acceptable.

It is simple to change the differential equation (1.2) in the previous
example to a linear first order differential equation.

dy
dt

=
2
t

y + t2.
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1
s

Integrator

4

Gain

ScopeSine Wave

Function

Figure 1.12: Connections for First Order
ODE model for dx

dt = 2 sin 3t− 4x.

Figure 1.13: Scope plot of the solution
of dx

dt = 2 sin 3t − 4x, x(0) = 0, with
Refine Factor= 1.

Example 1.2. Solve the linear first order differential equation,

dy
dt

=
2
t

y + t2, (1.3)

satisfying y(1) = 1.
We first rewrite Equation (1.3) in standard form,

dy
dt
− 2

t
y = t2. (1.4)

We can now determine the integrating factor,

µ(t) = exp
[
−
∫ t 2

τ
dτ

]
= exp [−2 ln t]

= t−2.

Multiplying Equation (1.4) by the integrating factor, µ(t), we can
find the solution:

t−2
(

dy
dt
− 2

t
y
)

= t−2t2

d
dt

(
t−2y

)
= 1

t−2y(t) = t + C

y(t) = t3 + Ct2. (1.5)

Using the initial condition, y(1) = 1, we obtain C = 0. Therefore,
the solution is y(t) = t3.
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Figure 1.14: System Configuration
Parameters.

Figure 1.15: Configure Data Im-
port/Export Parameters. Changing
theRefine Factor can lead to smoother
solutions.

The model for this problem is shown in Figure 1.22. Running the sim-
ulation, we obtain the numerical solution, y(t) = t3, as shown in Figure
1.23. Computing the difference between the numerical and exact solutions
in this case, we find the error is about 6× 10−5.

Example 1.3. Consider the initial value problem,

dx
dt

= 2 sin 3t− 4x, x(0) = 0. (1.6)

This is the example that we first solved using Simulink. It is an-
other linear first order differential equation. In standard form is is
written as

dx
dt

+ 4x = 2 sin 3t.

The integrating factor is found to be

µ(t) = exp
[∫

4 dt
]
= e4t.
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Figure 1.16: Scope plot of the solution
of dx

dt = 2 sin 3t − 4x, x(0) = 0, with
Refine Factor= 10.
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Integrator

4

Gain

Scope
Sine Wave

Function 1

Constant

Figure 1.17: Connections for the First
Order ODE model for dx

dt = 2 sin 3t− 4x
showing how to provide an external
initial value.

Multiplying Equation (1.6) by the integrating factor, we can obtain
the general solution:

d
dt

(
e4tx

)
= 2e4t sin 3t

e4tx = 2
∫

e4t sin 3t dt + C

=
2
25

e4t (4 sin 3t− 3 cos 3t) + C

x(t) =
2
25

(4 sin 3t− 3 cos 3t) + Ce−4t. (1.7)

Using the initial condition, x(0) = 0, we find C = 6
25 . Therefore,

the particular solution is

x(t) =
2

25
(4 sin 3t− 3 cos 3t) +

6
25

e−4t. (1.8)

The solution can be found using Simulink. The model for this
exact solution is shown in Figure 1.24. The plot on the scope matches
the solution we obtained earlier as seen in Figure 1.13.
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dy/dt yt 1/t 2/t

y' = 2/t y,  y(1)=1

Exact solution: y(t) = t
2

1
s

Integrator Scope

2

Gain

1

u
Math

Function

Clock

Product

Figure 1.18: First order separable
differential equation model.

Figure 1.19: Scope plot of the solution
of initial value problem (1.2), dy

dt = 2
t y,

where y(1) = 1.

1.3 Working with Simulink Output

Often we might want to access the solutions in MATLAB. Using
the model in Figure 1.18 for a first oder separable equation, we can add
the To Workspace block. This is shown in Figure 1.25. Double-click and
rename the variable as y and change the output type to array. When you
run the simulation, it will send the data to MATLAB for further analysis or
plotting. This will put tout and y data into the MATLAB workspace.

In MATLAB you can plot the data using plot(tout,y). You can add
labels with xlabel(‘t’), ylabel(‘y’), title(‘y vs t’). Adding the command
set(gcf,‘Color’,[1,1,1]) makes the plot background white. The result is
shown in Figure 1.26.

plot(tout,y)

xlabel(‘t’)

ylabel(‘y’)

title(‘y vs t’)

set(gcf,‘Color’,[1,1,1])

Once you have exported your data to the MATLAB workspace and
created a plot, then you can use the menu items under Tools to annotate
the plot. Once you are satisfied with the figure, go to the Edit menu and
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dy/dt yt 1/t 2/t

y' = 2/t y,  y(1)=1

Exact solution: y(t) = t
2
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Mat

Function2

Scope1

Figure 1.20: First order separable
differential equation model with extra
blocks to plot the difference between
the numerical and exact solution,
y(t)− t2, for Equation (1.2).

Figure 1.21: Scope plot of the difference
between the numerical and exact
solution, y(t)− t2, for Equation (1.2)

select Copy Figure. Go to your report document and Paste (CTRL-V) the
figure into your document. You can then resize the figure, center it, and
add a numbered Figure caption describing the figure. Other methods for
recording Simulink Scope images and the Simulink model are described
next.

1.4 Printing Simulink Scope Images

In this section we discuss different methods for transferring the plots
generated in Simulink models to a document or report. For example, you
might want to copy images produced by the scope or your model into an
MS Word document. There are several ways you can do this. You might
be able to use the Print icon to print to a file or printer, or you can follow
one of the following methods. Note: In 2015 it was not easy to export plots
from Simulink. In the 2017 versions, it is easier to do so and perhaps the
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2/t y

dy/dt y

t

1/t 2/t
y' = 2/t y+t ,   y(1)=1

Exact solution: y(t) = t

t
2

2

3

1
s

Integrator1 Scope1

2

Gain1

1

u
Math

Function1

Clock

Product1

u2

Math

Function2

Figure 1.22: Linear first order differen-
tial equation model.

Figure 1.23: Scope plot of the difference
between the numerical and exact
solution, y(t)− t2.

preferred method unless you are using earlier methods.
We compare the 2017a Scope figure windows to those shown later

from 2015a. In Figure 1.27 one might see slight differences in the Scope
icons. In Figure 1.28 the File menu shows a menu item for Print to Figure.
Here one can put the scope figure in a MATLAB figure environment and
Save As a figure file of different types such as the png image in Figure
1.29. Other methods are provided below for producing output useful for
reports.

Method 1:
Select the Scope figure window in Figure 1.30, then hit ALT+PrintScrn

to copy the figure to a clipboard and paste the figure into your application.
You might want to change the colors before copying the scope image. Changing the scope appearance.

Click the Scope Parameters icon (2nd icon) and go to the Style tab as seen
in Figure 1.31. Change the Figure Color to black, Axes Colors to white
background and black writing, and Line Color to black. The selection of
these parameters is shown in Figure 1.31.

Now the Scope plot looks like Figure 1.32.
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Sine Wave

ScopeSine Wave1

6/25*exp(-4*u(1))

Fcn
Clock

2/25

Gain

Figure 1.24: Model for plotting the
exact solution (1.8) of the initial value
problem (1.6).

dy/dt yt 1/t 2/t

y' = 2/t y,  y(1)=1

Exact solution: y(t) = t
2
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y

To Workspace

Figure 1.25: Adding To Workspace
block for sending output to MATLAB.

Method 2:
Go to Scope Parameters and select the History tab. Check the Save

data to workspace box. Note the variable name. Let’s change the name to
MyScopeData for this example. Saving with Structure with time will save
the data as a structure. Run the simulation again.

Now, go into the MATLAB command window. You should see the
MyScopeData data in the variable list. Type

plot(MyScopeData.time, MyScopeData.signals.values)

This gives the MATLAB plot in Figure 1.34 which can be manipulated
and saved or copied as an image.

Method 3:
You can save the scope image as a jpg image. Create the MATLAB code

in Table 1.1. Save this code as an m-file with a name like prfig.m. In MAT-
LAB run prfig (type prfig in the Command Window.) It should produce
the file ’mypic.jpg in your MATLAB folder. Of course, you can change the
name of the image before running prfig.m before inserting the figure into
your MS Word document as a Picture file.

Method 4:
You can add a To Workspace block to your simulation. This will auto- Add To Workspace block.

matically place the data in the MATLAB space. Go to the Simulink library
and add a To Workspace block to your model as discussed in the last sec-
tion. Connect this block to the input of the Scope (Right-click the input
line and drag to connect to the To Workspace block.) This will give the
connection as shown in Figure 1.36.
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y vs t Figure 1.26: Plot of model solution in

MATLAB.

Figure 1.27: Scope plot using MATLAB
2017a. Note the differences in some
icons.

You can double-click this block and change the variable name that will
be saved. Let’s assume it is simout. Then, run the simulation. Go into
MATLAB and type

plot(simout.time,simout.data)

This will give you a plot of the Scope data. Now you can print, save
as an image, or copy (under Edit) to an MS Word document. Below is
what you get using Copy Figure under the Edit menu item in the Figure
window.

Printing Models
Once you have made a model, you might want to include it in a report.

It is easy to capture a model, but a complicated model might not print Printing models.

large enough to see the component annotations.
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Figure 1.28: Scope plot showing File
menu where one can Print to Figure.

Figure 1.29: MATLAB png image
saved as png file. The colors and other
attributes can be changed before saving
the Scope plot.

First open the desired model. Then, in MATLAB you can use the print
command to print the model. For example, typing the following in the
MATLAB command window prints the open model to an encapsulated
postscript file:

print -s -deps -r300 mymodel.eps

For jpg files, you can use

print -s -djpeg -r300 mymodel.jpg

For other formats, consult the MATLAB help system.

1.5 Scilab and Xcos

There are alternatives to using MATLAB. One example is Xcos.
Xcos is part of Scilab. Scilab is free and open source software for numerical Xcos is part of Scilab, an open source

alternative.
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Figure 1.30: Scope plot. Note that the
plots in this section are generated by
the oscillator model in the next chapter.

Figure 1.31: Scope color parameters.

computation similar to MATLAB. Xcos is a graphical design environment.
The Xcos environment is shown in Figure 1.38.

After downloading and installing Scilab from http://www.scilab.org/,
one can type xcos or click on the icon to launch Xcos. This brings up
the Xcos Palettes browser and Xcos workspace as shown in Figures 1.39

and 1.40. This looks similar to Simulink’s Library Browser as shown in
Figure 1.5.

In Figure 1.41 we show the model for solving the first example of this
chapter:

dx
dt

= 2 sin 3t− 4x, x(0) = 0.

This is equivalent to the Simulink model in Figure 1.6. We see that this
model is similar to the Simulink construction. However, there are are some
differences. First of all, the block have a different appearance.

Next, there are some differences in setting up the block parameters. The
Sum block is set up by double-clicking the block and entering the signs
and number of input ports as [1;-1]. This indicates that the Sum block has

http://www.scilab.org/
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Figure 1.32: Scope plot with a white
background.

Figure 1.33: History tab in Scope
parameters.

two inputs. The first is positive and the second is negative.
The scope requires an additional input. Namely the time is entered

using a clock. In Simulink this is automatic, though we had also used the
clock to introduce time as an independent variable when needed.

The initial condition and the sine function parameters are entered by
double-clicking the integrator and sine block, respectively.

In order to run the simulation, one can click the “play” icon or select
Start under the Simulation menu item. The ODE solver can be changed
through Setup under the Simulation menu. The solution is shown in
Figure 1.42.

The blocks are not labeled like Simulink. One can label the blocks by
right-clicking and selecting Edit under the Format item. There one can
enter text to appear with the block. Annotation of the workspace is done
by selecting a Text_f block and adding text to it and changing the fontsize.
Sample annotations are shown in Figure 1.43.4 4 In newer Simulink versions the block

labels disappear. This can be changed
by going into the block Properties
and changing the model parameters
’HideAutomaticName’ or ’ShowName.’

We spent time earlier discussing how to capture images of the out-
put and models for reports. In Xcos it is a simple matter to Export the
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Figure 1.34: Plot generated by Method
2.

shh = get(0,’ShowHiddenHandles’);

set(0,’ShowHiddenHandles’,’On’)

set(gcf,’PaperPositionMode’,’auto’)

set(gcf,’InvertHardcopy’,’off’)

saveas(gcf,’mypic.jpg’)

set(0,’ShowHiddenHandles’,shh)

Table 1.1: MATLAB code for saving the
scope image as a jpg image.

model or the solutions by selecting Export under the File menu. There
are options for saving these to different formats. The images can also be
modified by changing the axis range, fonts, colors, etc.

1.6 First Order ODEs in MATLAB

One can use MATLAB to obtain solutions and plots of solutions of
differential equations. This can be done either symbolically, using dsolve,
or numerically, using numerical solvers like ode45. In this section we will
provide examples of using these to solve first order differential equations.
We will end with the code for drawing direction fields, which are useful
for looking at the general behavior of solutions of first order equations
without explicitly finding the solutions.

Symbolic Solutions

The function dsolve obtains the symbolic solution and ezplot
is used to quickly plot the symbolic solution. As an example, we apply
dsolve to solve the main model in this chapter.

At the MATLAB prompt, type the following:

sol = dsolve(’Dx=2*sin(t)-4*x’,’x(0)=0’,’t’);
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Figure 1.35: Scope plot from Method 3.

Figure 1.36: Use of a To Workspace
block.

ezplot(sol,[0 10])

xlabel(’t’),ylabel(’x’), grid

The solution is given as

sol =

(2*exp(-4*t))/17 - (2*17^(1/2)*cos(t + atan(4)))/17

Figure 1.44 shows the solution plot.
Another approach to symbolically solving a differential equation is

provided in the following code snippet. The dsolve command symboli-
cally solves the equation given by ’eq’ and using the initial condition in
’cond.’ It then plots the solution. This results in the same plot and solution
obtained earlier in the chapter.

syms t y(t)

dy = diff(y,t);

eq = dy + 4*y == 2*sin(3*t);

cond = y(0) == 0;

sol(t) = dsolve(eq,cond)

fplot(sol,[0 10])

xlabel(’t’)

ylabel(’y’)

title(’dy/dt-4y = t’)
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Figure 1.37: Scope plot from Method 4.

Figure 1.38: The Xcos workspace.

ODE45 and Other Solvers.

There are several ODE solvers in MATLAB, implementing Runge-
Kutta and other numerical schemes. Examples of its use are in the differ-
ential equations textbook. For example, one can implement ode45 to solve
the initial value problem

dy
dt

= − yt√
2− y2

, y(0) = 1,

using the following code:

[t y]=ode45(’func’,[0 5],1);

plot(t,y)

xlabel(’t’),ylabel(’y’)

title(’y(t) vs t’)
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Figure 1.39: The Xcos Palette browser.

Figure 1.40: The Xcos workspace.

One can define the function func in a file func.m such as

function f=func(t,y)

f=-t*y/sqrt(2-y.^2);

Running the above ode45 code produces Figure 1.45.
One can also use ode45 to solve higher order differential equations. Sec-
ond order differential equations are discussed in Chapter 3 Section 5. See
MATLAB help for other examples and other ODE solvers.
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Figure 1.41: The Xcos model for solving
the first order ODE dx

dt = 2 sin 3t− 4x.

Figure 1.42: The Xcos model solution of
dx
dt = 2 sin 3t− 4x, x(0) = 0.

Direction Fields

One can produce direction fields in MATLAB. For the differential
equation

dy
dx

= f (x, y),

we note that f (x, y) is the slope of the solution curve passing through the
point in the xy=plane. Thus, the direction field is a collection of tangent
vectors at points (x, y) indication the slope, f (x, y), at that point.

A sample code for drawing direction fields in MATLAB is given by

[x,y]=meshgrid(0:.1:2,0:.1:1.5);

dy=1-y;

dx=ones(size(dy));

quiver(x,y,dx,dy)

axis([0,2,0,1.5])

xlabel(’x’)

ylabel(’y’)

The mesh command sets up the xy-grid. In this case x is in [0, 2] and y
is in [0, 1.5]. In each case the grid spacing is 0.1.

We let dy = 1-y and dx =1. Thus,

dy
dx

=
1− y

1
= 1− y.

The quiver command produces a vector (dx,dy) at (x,y). The slope of
each vector is dy/dx. The other commands label the axes and provides a
window with xmin=0, xmax=2, ymin=0, ymax=1.5. The result of using the
above code is shown in Figure 1.46.
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Figure 1.43: The Xcos model with
annotation added.
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(2 exp(-4 t))/17 - (2 171/2 cos(t + atan(4)))/17 Figure 1.44: The solution of Equation
(1.1) with x(0) = 0 found using
MATLAB’s dsolve command.

One can add solution, or integral, curves to the direction field for dif-
ferent initial conditions to further aid in seeing the connection between
direction fields and integral curves. One needs to add to the direction field
code the following lines:

hold on

[t,y] = ode45(@(t,y) 1-y, [0 2], .5);

plot(t,y,’k’,’LineWidth’,2)

[t,y] = ode45(@(t,y) 1-y, [0 2], 1.5);

plot(t,y,’k’,’LineWidth’,2)

hold off

Here the function f (t, y) = 1− y is entered this time using MATLAB’s
anonymous function, @(t,y) 1-y. Before plotting, the hold command is
invoked to allow plotting several plots on the same figure. The result is
shown in Figure 1.47



introduction to simulink 25

t
0 0.5 1 1.5 2 2.5 3 3.5 4 4.5 5

y

0

0.1

0.2

0.3

0.4

0.5

0.6

0.7

0.8

0.9

1
y(t) vs t Figure 1.45: A plot of the solution of

dy
dt = − yt√

2−y2
, y(0) = 1, found using

MATLAB’s ode45 command.
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Figure 1.46: A direction field produced
using MATLAB’s quiver function for
y′ = 1− y.

1.7 Exercises

1. Construct the model in Figure 1.6 for solving the initial value problem
dx
dt = 2 sin 3t− 4x, x(0) = 0, and produce a plot of the solution.

2. Modify the model in the Problem 1. to solve
dx
dt

= f (t) − 2x for a

different function, f (t) and initial condition.

3. Solve the following initial value problems using MATLAB’s dsolve
command (See Section 1.6) and Simulink. Provide plots of the solutions
for both cases. How do the solutions compare?

a. y′ = xy, y(0) = 1.

b. y′ = 2y(3 − y), for different initial conditions, y(0) = 4,
y(0) = 2, and y(0) = −1.

c. y′ = 1 + x + y, y(0) = 1.

d. y′ = (y2 − 4)(y− 4) for different initial conditions, y(0) = 5,
y(0) = 3, y(0) = 1, y(0) = −1, and y(0) = −3.

4. Use MATLAB to plot direction fields for the following:
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Figure 1.47: A direction field produced
using MATLAB’s quiver function for
y′ = 1− y with solution curves added.

a. y′ = xy.

b. y′ = 2y(3− y).

c. y′ = 1 + x + y.

d. y′ = (y2 − 4)(y− 4).

5. Solve the following initial value problems using one of MATLAB’s
numerical ODE solvers like ode45. Plot the solutions and compare with
the corresponding solutions in Problem 3.

a. y′ = xy, y(0) = 1.

b. y′ = 2y(3 − y), for different initial conditions, y(0) = 4,
y(0) = 2, and y(0) = −1.

c. y′ = 1 + x + y, y(0) = 1.

d. y′ = (y2 − 4)(y− 4) for different initial conditions, y(0) = 5,
y(0) = 3, y(0) = 1, y(0) = −1, and y(0) = −3.
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